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LINK ENGINE MANAGEMENT LTD – LIMITED LIFETIME WARRANTY

All Engine Control Units (ECUs) manufactured or distributed by Link Engine Management Ltd are
subject to the following LIMITED LIFETIME WARRANTIES, and no others.

Link Engine Management Ltd warrants only to the original purchaser of the ECU, for the lifetime of
the ECU, (subject to the limitations set out below), that the ECU shall be free from defects of
materials and workmanship in the manufacturing process. This warranty ceases to apply and does
not apply to ECUs that have not been manufactured or distributed by Link Engine Management Ltd
for a period of greater than one year.

An ECU claimed to be defective must be returned to the place of purchase. Link Engine Management
Ltd, at its sole option, may replace the defective ECU with a comparable new ECU or repair the
defective ECU. 

This limited lifetime warranty is not transferable and does not apply to any ECU not properly installed
or properly used by the purchaser or end user, or to any ECU damaged or impaired by external
forces. The above warranties are the full extent of the warranties available on the ECU. Link Engine
Management Ltd has no liability to the original purchaser or any other person for any loss, injury or
damage to persons or property resulting from the use of the ECU or any failure of or defect in the
ECU whether by general, special, direct, indirect, incidental, consequential, exemplary, punitive, or
any other damages of any kind or nature whatsoever. Link Engine Management Ltd specifically
disclaims and disavows all other warranties, express or implied, including, without limitation, all
warranties of fitness for a particular purpose, warranties of description, warranties of merchantability,
trade usage or warranties of trade usage.

For off-road use only, not intended for highway vehicles. This ECU contains a user-configurable
software programme, which is updated by Link Engine Management Ltd from time to time. The user
must ensure the current correct version of this programme is downloaded from the website of Link
Engine Management Ltd and installed in the ECU prior to use. This limited lifetime warranty does not
apply where the ECU has been installed with the incorrect version of the software programme. The
user is solely responsible for the setup and testing of all user-configurable features. 

Link Engine Management Ltd License Agreement

The software programme in this ECU is licensed not sold. Link Engine Management Ltd grants the
user a license for the programme only in the country where the programme was acquired. No other
rights are granted under this license and the programme may only be used on one machine at a
time. If the programme is transferred a copy of this license and all other documentation must be
transferred at the same time. The license may be terminated by the user at any time. Link Engine
Management Ltd may terminate the licence if the user fails to comply with the terms and conditions
of this license. In either event the copy of the programme must be destroyed.

Product Warranty Statement
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1 G4X Plug-In ECU Installation Manual

1.1 Introduction

Thank you for purchasing your Link Plug-In Engine Control Unit (ECU), an advanced, fully programmable
microprocessor controlled Engine Management System.
G4X software employs high resolution fuel and ignition tables with configurable load and RPM centres. When
coupled with up to six dimensional fuel and ignition mapping, barometric pressure compensation and intake
air temperature correction this gives an unprecedented level of tuning accuracy. All Link G4X ECUs are in-field
upgradeable, there is no need to return the unit for software updates.
All Link G4X Plug-In Engine Management Systems are designed with flexibility and ease of installation in
mind. Link Plug-In systems are designed to replace the circuit board inside the factory ECU enclosure. This
provides an invisible install that requires minimal modification to vehicle wiring and ECU mounting.
Installing and tuning any after market engine management system is not to be taken lightly. G4X ECUs give
the tuner the control & flexibility that only top after-market engine management systems in the world can
provide. While every effort has been made to keep G4X ECUs as user friendly as possible, it should be
recognised that added features bring added complexity.
The complete setup of your ECU can be divided into two important tasks:
1. This manual covers the installation of your G4X ECU. While it is not strictly essential that this work is

performed by an automotive electrician, the knowledge and tools available to these professionals makes it
highly recommended. Regardless of who does the installation, it is of utmost importance that instructions
provided in this manual are followed exactly throughout the installation.

2. Once the G4X ECU has been installed it will need to be tuned using a laptop computer with PCLink
software. Information on the configuration and tuning of the G4X ECU is detailed in the help section of
PCLink. G4X ECUs are shipped pre-loaded with a base configuration that should be close enough to get
most engines running after a few application specific adjustments have been made. While hearing the
engine running on the new ECU for the first time is always a satisfying feeling, it is important to realise
that the job is not complete. The amount of tuning performed and the experience of the tuner are the two
most important factors in determining how happy you will be with your engine management system.

1.1.1 Safety Notice

Your Link Plug-In ECU is designed to enhance the performance of your vehicle. However in all cases, your
vehicle must be operated in a safe manner. Do not tune your vehicle while operating it on public roads.

WARNING!
Failure to follow all installation and operating instructions may result in damage to

the Link ECU, personal injury, or harm to property.

1.1.2 Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring harness
are correct. However due to variations between vehicle models it is the installers responsibility to check wiring
connections BEFORE installing the ECU. Link will not be held responsible for any damage caused by the
incorrect installation of this product.

1.1.3 Support Options

Should any issues arise during installation, the following options exist for technical support:
1. PCLink help, press F1 while running PCLink
2. Contact your nearest Link dealer. A Link dealer list is available on our website.
3. Link website: www.linkecu.com with Online Discussion Forum.
4. Technical Support Email: tech@linkecu.com
The majority of questions received by the technical support team are clearly answered in the manuals. Please
consult the manuals to make sure that your question has not already been answered.

1.2 Pre-Installation

Before installing the Link G4X ECU into the vehicle some pre-installation checks must be performed. 
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1.2.1 Compatibility Check

It is essential that a compatibility check is performed before installing the ECU into the vehicle. Failure to do
so may void the warranty. There are some cases where the same ECU connector is used on very similar
vehicle models but with a completely different pinout.

1.2.1.1 WRXLink (10)

There are two different Subaru Impreza WRX V10 ECUs available. These are categorised as 2004-2006
2500cc and 2007 2500cc. This maybe slightly misleading as some 2006 vehicles require a 2007 ECU.
It is critical that the correct ECU for the vehicle is installed, failure to install the correct ECU can
result in engine component, engine wiring or ECU damage.
The correct ECU can be verified by studying the wiring loom.
If pins A1, A2 and A3 (see pinout section) contain no wires, then the correct ECU required is the 2007
2500cc version. If these pins contain wires, then the correct ECU is the 2004-2006 2500cc version.

1.2.2 Board Switch Settings

Some Link G4X ECUs require switches on the board to be set before installation.

1.2.2.1 WRXLink (10)

There are jumpers located on the circuit board inside the case. These jumpers configure changes Subaru
made between years. 
The jumpers MUST be set before installing the adapter in the vehicle.

When the jumper consists of three pins in a row,
correct selection is made by moving the jumper to
the appropriate end of the three pins.

When the jumper consists of four pins in a
square, correct selection is made by positioning
the two jumpers in either vertical or horizontal
orientation.

Information regarding the correct jumper position for the vehicle is printed on the PCB. 
To access the jumpers, one end plate must be removed from the case and the PCB will slide out. Ensure the
adapter is fully unplugged before removing the end plate.

1.2.3 Injector Impedance

Injector impedance is important and needs consideration before installing the ECU.

1.2.3.1 Subaru Impreza WRX V1-11 ECU

The G4X Subaru V1-11 Plug-In ECUs are NOT designed to be used directly with low impedance injectors.
All models this ECU is designed for are fitted with high impedance injectors from factory. This ECU has been
designed to be used with HIGH impedance (greater than 6 Ohms) injectors. Ballast resistors must be wired if
low impedance injectors are to be used. This means that the ECU is plug-in compatible with factory fitted
injector combinations on all models, however if fitting low impedance injectors then ballast resistors must be
wired. Contact your nearest Link dealer to purchase a ballast resistor pack if required.
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1.3 Installation

This guide provides information on correctly and safely installing your new Link G4X Plug-In ECU.

1.3.1 ECU Handling Procedures

WARNING!!!
The following installation process will require handling of both the Link ECU and

factory ECU. Both of these are highly sensitive to electrostatic discharge and are
easily damaged. Follow the anti-static precautions given in this manual carefully

to avoid damaging electronic components. Warranty claims for ECUs damaged by
electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can reach very high
voltages. Whenever given the opportunity this energy will attempt to discharge (usually through

your finger tips!). This can be fatal to most electronic components. Most people have
experienced an electrostatic discharge when they step out of their car or touch a metal bench

top. 
The following guidelines describe precautions that can be taken to reduce the possibility of

damaging your ECU:

1. Work only on a conductive surface. A clean steel bench is suitable.
2. Always wear a wrist strap that is electrically connected to the conductive 

working surface. An Anti-static wrist strap is included for use during install
3. Touch the working surface regularly.
4. Do NOT touch components on the circuit board.
5. Where possible, only handle the ECU by its plastic header.
6. Do NOT carry the ECU around without anti-static packaging. 
7. Do NOT touch the bare terminals in the ECU header.

Observing the above procedures will minimise the chance of damaging the ECU. Note that
failure due to static damage often does not appear until well after it was caused.

1.3.2 Fitting the ECU

Information is provided to assist in fitting the ECU into the vehicle.

1.3.2.1 WRXLink (04) and WRXLink (07)

The following steps outline the installation procedure for Subaru Plug-In ECUs:
1. Remove the factory ECU from the vehicle: Ensure the key is in the OFF position. The factory ECU is

located under a steel cover on the passengers side floor (below the passengers feet). Lift the carpet,
remove the cover panel. Unplug the wiring harness from the factory ECU. Remove the 6mm bolts (10mm
socket) that retain the ECU and remove the ECU from the vehicle. DO NOT touch the exposed pins in the
factory ECU connector.

2. Remove the factory ECUs circuit board from its enclosure: Ensure you are following the given anti-static
guidelines and ARE WEARING A CONDUCTIVE WRIST STRAP connected to a conductive working
surface. Remove the top and cover from the ECU enclosure by removing the side retaining screws.
Remove the circuit board by removing the retaining screws. Hold it only by the plastic header and place it
aside.
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3. Fit the Link Plug-In ECU: Remove the ECU from its packaging and place it immediately in the factory
enclosure. Place the factory ECU in the packaging your Link ECU came in for its protection.

Note: The G4X WRXLink (04) Plug-in ECU can fit two case sizes. If the ECU PCB is too large for the case,
carefully snap the PCB extensions off at the lines shown in the image below.

4. If the ECUs USB tuning cable is to be left permanently connected, a slot will need to be cut in the top
cover. The best place to do this is usually beside the factory header.

5. Reassemble the enclosure and fit the ECU back to the vehicle.
6. Connect the ECU to the factory wiring loom. 
7. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual first.

1.4 Additional Sensors/Functions

G4X Plug-In ECUs offer various options for the installation of additional sensors and devices. As a minimum it
is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP) sensor and Intake Air
Temperature (IAT) sensor. These parts can be purchased if required from your nearest Link dealer. 

1.4.1 MAP Sensor

It is important that the pressure source for a MAP sensor be taken from a stable pressure source after the
throttle body. It is common to 'T' into the fuel pressure regulators pressure signal. Do NOT share this signal
with other devices such as boost gauges or blow off valves.

Note: Internal MAP Sensors on new plug-in ECUs have changed from 4Bar to 7Bar. The 7Bar versions should
be identifiable by a sticker on the bottom board and can also be confirmed by comparing MAP and BAP when
the MAP vacuum line isn't connected to see if they match with the calibration being used.

1.4.1.1 WRXLink (04), WRXLink (07) & WRXLink (11)

The Link G4X WRXLink (04), WRXLink (07) & WRXLink (11) plugins support several options for fitting of a
MAP sensor, any one of the following options can be used:
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1. Factory MAP Sensor – From factory, all models supported by this ECU are fitted with a factory MAP
sensor. The factory MAP sensor is wired to An Volt 1. The factory sensor is good for 160kPa (23psi) of
boost.

2. Factory MAP Sensor Upgrade – The factory MAP sensor can be upgraded by simply replacing the factory
MAP sensor. Contact your nearest Link dealer for upgrade options.

Make sure that the correct MAP sensor input has been selected in PCLink and a MAP calibration has been
performed before attempting to start the vehicle.

Note: We have found two different MAP sensor calibrations used in the WRXLink (11). Most STI’s use the
“Subaru V9” calibration and the more basic WRX’s use the “Subaru V7-8” calibration. The correct selection
can be confirmed by checking that the BAP runtime matches the MAP runtime. See section 1.6.3

1.4.2 IAT Sensor

It is highly recommended that an IAT sensor be fitted in all applications to provide an input for correction of
fuel and ignition based on the engines air charge temperature.
An IAT sensor should be fitted in the intake system in a location that accurately represents intake
temperature. The most common location is just prior to the throttle body. Installing in the manifold is not
recommended due to heat soak issues. A fast response sensor must be used in all forced induction
applications.

1.4.2.1 WRXLink (04), WRXLink (07) & WRXLink (11)

Some STI’s have a factory fitted IAT sensor near the throttle body, if your car has this it is suitable for use as
is. This STI sensor is connected to AN Temp 3. 
The AFM has a factory fitted IAT sensor. Due to its location this sensor is not suitable for tuning. A suitable
IAT sensor can however be wired to the AFM wiring. The AFMs IAT signal is wired to An Temp 2. Factory
AFM wiring information follows:

1 +14V
2 Ground
3 Mass Air Flow Meter (Typically An Volt8)
4 Intake Air Temperature (An Temp 2)
5 Ground

Note: It is important that the factory IAT sensor is completely disconnected as not to affect the after market
IAT sensor signal.

An IAT sensor can also be wired in using any spare An Temp or An Volt pin (several are available on the
expansion connectors). Note spare An Volt channels require a pullup resistor (to +5V) to be added for
temperature input use.

1.4.3 E-Throttle Output

1.4.3.1 WRXLink (04), WRXLink (07) and WRXLink (11)

This vehicle has E-Throttle from factory.
The E-Throttle Output pins are Aux 9 & 10 and the EThrottle Relay is Aux Ignition 8. If the EThrottle is found
to be operating in the wrong direction this can be rectified by changing the Aux 9 Active State (Electronic
Throttle -> E-Throttle 1 -> E-Throttle Setup or by swapping the +ve and -ve pins at the throttle plug.

1.4.4 Expansion Connector

Expansion connectors are provided to allow easy connection of additional ECU inputs. An “expansion cable”
can be purchased from your Link dealer. 



G4X Plug-In ECU Instal lation Manual 11

© 2023  Link Engine Management Ltd

Important points when wiring to the expansion connector:
· Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V out signal also

provides power for other sensors.
· Do not connect the ground pin to chassis ground. This could cause ground loops and introduce

unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

The Expansion connectors available for each ECU can be found under the Pinouts Section.

1.5 PC Tuning

G4X ECUs require PC/laptop tuning using the PCLink Tuning Software application running on a Windows
based computer. PCLink may be downloaded from www.linkecu.com. Note that when new versions of PCLink
are released they are posted on the website and may be downloaded at no cost. Also note that G4X ECUs
must be used with the correct version of PCLink.

IMPORTANT!
The G4X ECU has on board USB.

BEFORE connecting the ECU to your laptop, the USB drivers must be installed.
Failure to install the drivers on your laptop first may result in windows assigning
incorrect drivers. These drivers will not work with the G4X ECU and are difficult to
uninstall. The correct USB drivers are installed as part of PCLink installation, as
described in the following section. Should internet download not be practical, a

copy of the drivers on CD can be obtained from your nearest Link dealer.

1.5.1 Installing USB Drivers

Before connecting the ECU to your laptop or PC, the ECU USB drivers must be installed. These drivers are
installed as part of PCLink installation as described in the following section.

1.5.2 Installing PCLink Tuning Software

Due to the frequent updates PCLink is no longer shipped with each ECU. You will be required to download the
latest version of PCLink from: linkecu.com
Should access to an Internet connection be impractical, download the latest version of PCLink elsewhere to a
USB drive, and then install on your laptop.
Installing from the web
1. Go to the above website and navigate to the downloads and software updates section.
2. Download the latest version of PCLink. When prompted to run or save the file, select save. It is

recommended to save this file on the desktop.
3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes. This may take some time.
5. When installed, open PCLink by double clicking on the icon that has been placed on the desktop.

1.5.3 Communicating With Your ECU

After PCLink installation, you will be able to connect the G4X ECU to the laptop to perform set-up and tuning
work.
1. Connect the ECU to your laptop using a Link G4X ECU USB Cable. If not supplied with the ECU, these

can be purchased from a Link dealer. No other adapter or cabling is required. Connect the cable to the
connector labelled USB.

2. If this is the first time you have connected a G4X USB ECU to your laptop follow the driver installation
instructions that appear. When prompted if you want to install drivers select 'Continue Anyway'.

3. Start PCLink by double clicking on the PCLink icon on the windows desktop.
4. Switch the key to the ON position. This will provide power to the ECU.
5. In PCLink, under the 'Options' menu, select 'Connection'. The connection options dialogue will open.

Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.

6. PCLink offers both mouse and keyboard control. To establish a connection between the PC and ECU
press the F3 key. The same process can be used to disconnect. If a successful connection is
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established, PCLink will download settings from the ECU, otherwise you will be warned that an error has
occurred.

7. Make sure the connection shows “ONLINE” in the top right corner of PCLink.
8. To permanently STORE any changes made to the ECU press F4. If this is not done before turning the

ECUs power off all changes made will be lost.

1.6 Pre-Start Configuration

Before starting the vehicle, important pre-start configurations need to be made.

1.6.1 Firmware Version

It is recommended to ensure that the Link G4X ECU is running the most up to date firmware. Firmware
version information can be obtained by connecting to the ECU with PCLink and selecting 'ECU Information'
under the Help menu.
The latest firmware can be downloaded from our website with PCLink. 
It is recommended that this is performed by an experienced Link dealer as new features may need to be
properly configured.
The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in PCLink, follow
the on screen instructions to complete the firmware update process.

1.6.2 Base Configuration

All G4X Plug-In ECUs are shipped with base configuration settings. Note that these are provided to reduce
initial setup and tuning times. They are NOT recommended tuning values. PCLink includes base
configurations for various models. Download the appropriate base configuration into your ECU with PCLink by
connecting to the ECU (described in the Connecting To PCLink section of this manual), then selecting 'Open'
under the 'File' menu. Select the appropriate .pclx file and then select 'Open'. Downloading large configuration
files can take up to a few minutes. Be patient and acknowledge any messages PCLink shows.

1.6.3 MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match the
Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction, the BAP sensor also
allows the MAP sensor to be calibrated prior to tuning.
Link G4X ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This ensures that all
PCLink Tuning Software programs (pclx Files) give a consistent state of tune throughout the ECU range. This
allows a pclx file to be transferred between G4X based ECUs giving an equivalent state of tune providing all
factors affecting volumetric efficiency are equal.
Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be
significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge Pressure
(MGP) as a load index.
To calibrate the MAP sensor:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP sensor.

Select the correct MAP Sensor Type.
3. Under the 'Options' menu, select 'MAP sensor calibration'.
4. Follow the on screen instructions.
5. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).
7. Perform a 'Store' by pressing F4.

A more in depth explanation is provided in the PCLink help Manual under PCLink G4X Users Manual ->
Tuning Operating Procedures -> ECU Controls -> MAP Sensor Calibration.

1.6.4 TPS Calibration

E-Throttle Vehicles:
The Throttle Position Sensors (TPS Main and Sub) and Accelerator Position Sensors (APS Man and Sub) are
used by the ECU to control the throttle blade position and to calculate various engine management



G4X Plug-In ECU Instal lation Manual 13

© 2023  Link Engine Management Ltd

parameters used by functions such as idle speed control,acceleration enrichment and motor sport features. It
is very important that these inputs are setup correctly and the E-Throttle operation is tuned properly before
starting or driving the vehicle, failure to do so can result in damage to the Throttle body, engine, vehicle and
even the operator and bystanders. The following procedure shows how to calibrate the APS and TPS sensors:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Open Electronic Throttle -> Accelerator Position Sensor and ensure that the APS (Main) Source and APS

(Sub) Source settings are set to the correct inputs. Refer to the Pinouts section of this manual for details.
3. In the same window double-click on 'APS Calibration' and follow the instructions on the screen.
4. Open Electronic Throttle -> E-Throttle 1 -> Throttle Position Sensor and ensure that the TPS (Main)

Source and TPS (Sub) Source settings are set to the correct inputs. Refer to the Pinouts section of this
manual for details.

5. In the same window double-click on 'TPS Calibration' and follow the instructions on the screen.
6. If your vehicle has two E-Throttles then repeat the above two steps for TPS 2(Main) and TPS 2 (Sub) in E-

Throttle 2.
7. Select the 'General' tab in the runtime values section of PCLink (lower part of the screen).
8. Ensure the APS (Main) and APS (Sub) values read 0% when the pedal is released and 100% when fully

depressed.
9. Perform a 'Store' by pressing F4.

1.6.5 IAT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the intake
system. It is important that the ECU is calibrated to match the sensor installed in the engine. This procedure
is as simple as selecting the correct sensor type as follows:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Click on 'Analog Channel' in the configuration tree.
3. Select the An Temp channel the sensor has been wired to.
4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.
5. Select the correct 'Temp Sensor Type'.
6. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
7. Ensure that IAT reads the correct temperature.
8. Perform a 'Store' by pressing F4.

1.6.6 Input and Output Setup

As the Link G4X Plug-In ECUs are designed to run several models there are a few items that must be set-up
to make the ECU specific to your model. 
The Pinouts section of this manual gives a list of the functions of each channel based on the target vehicle.
It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:
All Auxiliary Output Channels 
Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.
All Digital Inputs
Look at the Digital Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.
All Analog Volt and Temperature Inputs
Look at the Analog Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.

1.6.7 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous sections have been
completed. Only after all pre-start checks have been made should an attempt be made to crank the engine.
The following steps must be performed before an attempt is made to start the engine to ensure the G4X ECU
is calibrated to precisely measure engine position.
1. Connect the ECU to PCLink.
2. Select 'Fuel', then 'Fuel Set-up':

a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers are
calibrated.
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b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.
3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the PCLink help

(Press F1).
Note that trigger calibration must be performed again once the engine is running. Due to the acceleration and
deceleration of the crankshaft at low speeds, an inaccurate measurement of engine timing is usually made.
Also it is often harder to see timing marks with a timing light at slow engine speeds. Trigger calibration should
be checked again at between 2000-4000 RPM where engine speed is stable and a more consistent timing
reading can be obtained.

A more in depth explanation is provided in the PCLink help Manual under G4X ECU Tuning Functions ->
Triggers -> Calibration.

1.7 First Time Startup

For further help on any of the settings discussed below, consult the Help in PCLink Tuning Software. Help
can be invoked by pressing F1, or right clicking any item and selecting ‘What’s this?’.

Pre-set-up Checks
Before attempting to configure the ECU, ensure the following tasks have been completed:
1. Ensure the ECU and all associated components are connected and correctly wired/installed.
2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the set-up

procedure.
3. Check all oil and water levels are correct.

Connecting to PCLink Tuning Software
Use the following procedure to establish a connection between your Link ECU and PCLink Tuning Software
tuning software.
1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to PCLink as described in the 'Communicating with your

ECU' section of this manual. 

First Time Startup
After performing all set-up instructions given in previous sections, including trigger calibration, the engine is
now ready to be started. The following procedure should be used for first time start-up.
1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.
2. Connect the ECU to PCLink.
3. Access the runtimes values by pressing the F12 Key, click the 'Analog' tab:

a. TPS – spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration. If the vehicle
has an E-Throttle confirm that APS (Sub), APS (Main), TPS (Sub), TPS (Main) all operate correctly
and that the throttle blade tracks the target correctly.

b. MAP – should read approx 101 kPa (at sea level) with the engine not running. If not, check the MAP
Sensor Type setting and perform a MAP Calibration.

c. ECT – should read current engine temperature.
d. IAT – should read current intake air temperature.
e. Digital Inputs (click the 'Digital' tab) – Operate switches connected to any digital inputs while watching

the runtime value to ensure they operate as expected.
4. Rectify any faults found in Step 3.
5. Ensure the basic Fuelling setup is correct.

a. If using Traditional Fuel Equation Mode then locate the 'Master Fuel' setting in the ECU Settings Menu
under: Fuel > Fuel Setup > Fuel Main. This will need to be adjusted during or just after start-up.

b. If using one of the Modelled Fuel Equation Modes then navigate to Fuel > Fuel Setup > Fuel main and
enter the correct engine capacity, correct base fuel pressure, and correct fuel properties. Navigate to
>Fuel>Fuel Setup>Injector Setup, enter correct injector flow rate and rated pressure.

6. Crank the engine until it starts. Some throttle may be required for first time start-up due to imperfect
tuning.
a. If using Traditional Fuel Equation Mode the Master Fuel settingcan be used to enrich/lean the engine

(increase to enrich).
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b. If using one of the Modelled Fuel Equation Modes the Injector Flow Rate can be decreased to add
more fuel, this will need to be changed back to the correct value later but works well for first start
purposes.

7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine the
problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value increases
during cranking/running then there is a trigger setup fault. It is not unusual for this number to count one or
two on the first engine revolution.

9. Once the engine starts:
a. If using Traditional Fuel Equation Mode adjust the Master Fuel setting to achieve best possible running
b. If using one of the Modelled Fuel Equation Modes adjust the Injector Flow Rate setting to achieve best

possible running, this will need to be changed back to the correct value later but works well for first
start purposes.

10. The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’ several
times to maintain smooth running. Don’t forget to keep an eye on engine temperature.

11. Once the engine is warmed up and running well, perform another trigger calibration (known “as setting the
base timing”).

12. Perform a Store by pressing F4.

Essential Tuning Adjustments
It is assumed that at this stage all set-up procedures described in previous sections have been completed
and the engine is running. The following steps detail correct set-up procedures for some of the more critical
ECU parameters (note that MAP Sensor Calibration should have already been completed by now):

Injector Voltage (Dead-time) Correction
There is always a delay between the injector being energised and the injector actually opening. Likewise,
there is a small delay between the injector being de-energised and the injector closing. The opening time is
considerably longer than the closing time, however the overall result is that less fuel will flow for a given pulse
width than would be expected with an 'ideal injector'. To compensate for this the injector pulse widths are
increased to compensate for this 'dead-time'. The dead-time for a given injector is a function of the battery
voltage, differential fuel pressure and the type of injector driver (saturated or peak and hold). A typical dead-
time at 3 Bar differential fuel pressure and 14 volts is just under 1ms (ms = millisecond = 1 thousandth of a
second). 
In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant. Therefore the only variable
that is changing will be the battery voltage (this changes with electrical load and sometimes engine speed).
Without correction, the changes in dead-time will cause the engine to run lean when the voltage drops. If the
Injector Voltage Correction is properly set-up then changes in the battery voltage will not affect the air/fuel
ratio.
The injector dead-time table allows the dead-time for different battery voltages to be entered. The values
represent the dead-time in milliseconds. These should increase with falling system voltage.
Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine. 
To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set voltage. Vary the supply
voltage to the injector and measure minimum pulse width at which the injectors will flow for a particular
voltage. This is the required dead-time for that injector at that tested voltage. 
To determine injector dead-time on a running engine, with the engine fully warmed and operating at stable
air/fuel ratios (a very precise AFR meter is required – a narrow band O2 sensor will not suffice), electrical
drain needs to be applied to the system; the preferred method is disconnecting the alternator main fuse.
Battery load testers are also useful here too.
Watching the air fuel ratios change while the battery voltage drops, the dead-time table can be trimmed to
maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row graph. A smooth curve
needs to be maintained at all times.
NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.

Traditional Fuel Equation Mode Master Fuel Setting
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If using Traditional Fuel Equattion mode the Master Fuel setting should be set so that the numbers in the
middle of the fuel table end up around a value of 50. This is to allow sufficient span of the numbers in the main
fuel table.

1.8 Pinouts

Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire side).

1.8.1 WRXLink (04) and WRXLink (07)

The following pin diagram is provided as a support reference. Please contact your nearest Link dealer for
specific pin information.

2004 - 2006 ECU Function

Pin ECU Pin Function Pin ECU Pin Function

A1 DI 4 Clutch Switch C3 Injector 4 Injection

A2 nc C4 Injector 3 Injection

A3 nc C5 Injector 2 Injection

A4 nc C6 Injector 1 Injection

A5 nc C7 DI10 Cruise Main

A6 Ground C8 nc (Brake NO)

A7 nc C9 DI 5 Brake Switch (NC)

A8 Aux 8 Tumble Valves Close C10 DI 6 Cruise Cancel OR Resume

A9 Linked to A10
TGV wired in series

C11 DI 7 Cruise Set OR Cancel

A10 Linked to A9 C12 An Temp 3 Fuel Temperature

A11 Aux 7 Tumble Valves Open C13 An Temp 2 IAT from MAF

A12 nc C14 An Temp 1 ECT

A13 nc C15 +5V Out

A14 Injector 5 (Aux) Purge Solenoid C16 +5V Out

A15 Injector 6 (Aux) Cruise Light C17 An Volt 10 APS (Main)

A16 nc (Cruise Set
Light)

C18 An Volt 2 TPS (Main)

A17 Injector 8 (Aux) CE Light C19 nc

A18 +14V Out AVCS Solenoid C20 nc

A19 +14V Out AVCS Solenoid C21 nc

A20 nc C22 An Volt 1 MAP

A21 nc C23 An Volt 8 MAF Signal

A22 nc C24 nc

A23 Aux 3 Tacho C25 Knock 1 Knock

A24 nc C26 An Volt 4 Left TGV Position

A25 Ground C27 An Volt 5 Right TGV Position

A26 nc C28 An Volt 9 APS (Sub)

A27 nc C29 An Volt 3 TPS (Sub)

A28 Aux 2 Bank 1 (RH) AVCS
Solenoid

C30 nc

A29 Aux 1 Bank 2 (LH) AVCS
Solenoid

C31 Ground (AFM)
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A30 nc C32 Ground (AFM
Shield)

A31 nc C33 Ground (Knock
Shield)

A32 Aux 5 Wastegate Solenoid C34 Ground (APS)

A33 nc C35 Ground (Signal)

A34 Ground (Signal)

D1 Ground (Signal)

 B1 Ground D2 Ground (Signal)

B2 Injector 7 (Aux) Rear Oxy Heater D3 Ground

B3 nc D4 Aux 9 EThrottle Motor +

B4 Ground D5 Aux 10 EThrottle Motor -

B5 +14V Main Relay ECU Power D6 +14V EThrottle From EThrottle Relay

B6 +14V Main Relay ECU Power D7 Ground

B7 nc D8 DI 8 Start Signal

B8 Trig 2 Bank 2 (LH) Cam
Position

D9 DI 9 Neutral Signal

B9 DI 2 Bank 1 (RH) Cam
Position

D10 An Volt 6 Power Steer Switch

B10 Trig 1 Trig 1 (Crank) D11 nc

B11 nc D12 nc

B12 Ground D13 nc

B13 nc D14 Ignition Switch (05-
06)

Controls Main Relay (05-06)

B14 nc D15 Ignition Switch (04) Controls Main Relay (04)

B15 Ignition 4 Ignition D16 DI3 (04) / Main
Relay (05-06)

AC Request (04) / Ground
when on (05-06)

B16 Ignition 3 Ignition D17 Main Relay (04) /
DI3 (05-06)

Ground when on (04) / AC
Request (05-06)

B17 Ignition 2 Ignition D18 nc

B18 Ignition 1 Ignition D19 nc

B19 nc D20 nc

B20 nc D21 nc

B21 nc D22 nc

B22 Ground (Cams) D23 nc

B23 nc D24 nc

B24 Ignition 5 (Aux) AC Fan D25 An Volt 7 Rear Oxy Signal

B25 Ignition 7 (Aux) Engine Fan D26 nc

B26 Aux 6 (04) / DI 1
(05-06)

FP Speed (04) / Vehicle
Speed (05-06)

D27 nc

B27 DI 1 (04) / Aux 6
(05-06)

Vehicle Speed (04) / FP
Speed (05-06)

D28 nc

B28 nc D29 nc

B29 nc D30 nc

B30 nc D31 Ground (Shield)

B31 Ground (Crank
Shield)

Expansi
on 1

Ground (Signal)

B32 nc Expansi
on 2

+5V Out

B33 Ignition 6 (Aux) AC Relay Expansi
on 3

nc



Link ECU Online Manual18

© 2023  Link Engine Management Ltd

B34 nc Expansi
on 4

nc

B35 Ignition 8 (Aux) E-Throttle Relay Expansi
on 5

An Volt 12

Expansi
on 6

nc

C1 nc Expansi
on 7

An Temp 4

C2 nc Expansi
on 8

An Volt 11

2006-2007 ECU Function

Pin ECU Pin Function Pin ECU Pin Function

A1 nc C3 nc (Front O2
Heater)

A2 nc C4 Injector 7 (Aux) Rear Oxy Heater

A3 nc C5 nc

A4 nc C6 Ground (Shield)

A5 Ground C7 nc

A6 An Volt 1 MAP (Factory) C8 nc

A7 +14V Main Relay ECU Power C9 Ignition 6 (Aux) AC Relay

A8 nc C10 nc

A9 nc C11 Injector 8 (Aux) CE Light

A10 nc C12 nc (06) / Aux 6 (07) FP Speed (07)

A11 DI 2 Bank 1 (RH) Cam
Position

C13 DI 1 Vehicle Speed

A12 nc C14 nc

A13 Trig 1 Trig 1 (Crank) C15 Ground (Signal)

A14 Ground (Crank) C16 nc

A15 Knock 1 Knock C17 nc

A16 An Volt 4 Left TGV Position C18 Ignition 7 (Aux) Engine Fan

A17 nc C19 nc

A18 An Volt 2 TPS (Main) C20 nc

A19 +5V Out C21 Ignition 8 (Aux) E-Throttle Relay

A20 nc C22 Aux 3 Tacho

A21 Trig 2 Bank 2 (LH) Cam
Position

C23 DI 3 (06) / Main
Relay (07)

A/C Request (06) / Ground
when on (07)

A22 Ground (Cams) C24 Main Relay (06) / DI
3 (07)

Ground when on (06) / A/C
Request (07)

A23 nc C25 DI 4 Clutch Switch

A24 Ground (Crank
Shield)

C26 nc

A25 Ground (Knock
Shield)

C27 CAN 2 High

A26 An Volt 5 Right TGV Position C28 nc

A27 nc C29 Ignition 5 (Aux) AC Fan

A28 An Volt 3 TPS (Sub) C30 nc

A29 Ground (Signal) C31 DI 9 Neutral Signal

A30 nc C32 DI 8 Start Signal

A31 nc C33 nc

A32 nc C34 nc
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A33 An Volt 6 Power Steer Switch C35 CAN 2 Low

A34 An Temp 1 ECT

D1 Ground

 B1 Ground (O2 Shield) D2 Ground

B2 +14V Main Relay ECU Power D3 Ground

B3 nc (Cruise Set
Light)

D4 Aux 9 EThrottle Motor +

B4 An Volt 7 Rear Oxy Signal D5 Aux 10 EThrottle Motor -

B5 nc (+12V constant) D6 nc

B6 Injector 6 (Aux) Cruise Light D7 Ground

B7 nc D8 Injector 1 Injection

B8 nc (Front O2 Signal
-)

D9 Injector 2 Injection

B9 nc (Front O2 Signal
+)

D10 Injector 3 Injection

B10 nc (Fuel Level
Sensor)

D11 Injector 4 Injection

B11 nc D12 Linked to D23 TGV wired in series

B12 DI 10 Cruise Main D13 Aux 8 Tumble Valves Close

B13 DI 6 Cruise Cancel OR
Resume

D14 Aux 1 Bank 2 (LH) AVCS Solenoid

B14 nc D15 +14V Out AVCS Solenoid

B15 nc D16 Aux 2 Bank 1 (RH) AVCS Solenoid

B16 nc D17 +14V Out AVCS Solenoid

B17 An Temp 3 Fuel Temperature D18 Ignition 1 Ignition

B18 An Temp 2 IAT from MAF D19 Ignition 2 Ignition

B19 Ignition Switch Controls Main relay D20 Ignition 3 Ignition

B20 DI 5 Brake (NC) D21 Ignition 4 Ignition

B21 +5V Out (APS
Main)

D22 Aux 7 Tumble Valves Open

B22 +5V Out (APS
Sub)

D23 Linked to D12 TGV wired in series

B23 An Volt 10 APS (Main) D24 nc

B24 DI 7 Cruise Set OR
Cancel

D25 nc

B25 nc D26 Ground

B26 An Volt 8 MAF Signal D27 Aux 5 Wastegate Solenoid

B27 nc D28 nc

B28 nc (brake NO) D29 Injector 5 (aux) Purge Solenoid

B29 Ground (APS Main) D30 nc

B30 Ground (Signal) D31 nc

B31 An Volt 9 APS (Sub) Expansio
n 1

Ground (Signal)

B32 nc (Fuel Tank
Pressure)

Expansio
n 2

+5V Out

B33 Aux 6 (06) / nc (07) FP Speed (06) Expansio
n 3

DI 11

B34 Ground (AFM) Expansio
n 4

Aux13

B35 Ground (AFM
Shield)

Expansio
n 5

An Volt 11
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Expansio
n 6

Aux 12

C1 +14V EThrottle From EThrottle
Relay

Expansio
n 7

An Temp 4

C2 nc (Front O2
Heater)

Expansio
n 8

Aux 11

1.9 CAN Information

The following CAN (Controller Area Network) information is provided:

1.9.1 WRXLink (04) and WRXLink (07)

The G4X WRXLink (04) and WRXLink (07) Plug-in ECU has two CAN buses. These CAN buses exist to
support aftermarket CAN devices.

CAN bus 1 uses a 5 pin connector and is labeled on the ECU as 'CAN 1/RS232'.
If using this connector for CAN ensure the cable being used doesn't have Serial wires connected as this can
act as an aerial and prevent USB communications from working.

CAN 1/RS232 Connector

Pin Function Colour

1 Comms GND Brown

2 CAN1 L Green

3 CAN1 H White

4 RS232-RX Grey

5 RS232-TX Yellow

CAN bus 2 uses a 5 pin connector and is labeled on the ECU as 'CAN 2/OBD'.

CAN 2/OBD Connector

Pin Function Colour

1 GND Brown

2 CAN2 L Green

3 CAN2 H White

4 NC Grey

5 +14V Yellow

To learn more about CAN see PCLink help.

1.10 Known Issues

All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often variations that have
not been tested. For this reason issues can arise.

WARNING: Always download the latest Installation Manual from linkecu.com and check the latest status of
known issues before installing the ECU.

Please contact your nearest Link dealer when suspecting a compatibility issue.
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1.10.1 WRXLink (04) and WRXLink (07)

Some vehicles don't have fuel temp sensors, if this is the case for your vehicle then turn off the fuel sensor
input or it's incorrect temperature reading will affect your fuelling.


	G4X Plug-In ECU Installation Manual
	Introduction
	Safety Notice
	Disclaimer
	Support Options

	Pre-Installation
	Compatibility Check
	WRXLink (10)

	Board Switch Settings
	WRXLink (10)

	Injector Impedance
	Subaru Impreza WRX V1-11 ECU


	Installation
	ECU Handling Procedures
	Fitting the ECU
	WRXLink (04) and WRXLink (07)


	Additional Sensors/Functions
	MAP Sensor
	WRXLink (04), WRXLink (07) & WRXLink (11)

	IAT Sensor
	WRXLink (04), WRXLink (07) & WRXLink (11)

	E-Throttle Output
	WRXLink (04), WRXLink (07) and WRXLink (11)

	Expansion Connector

	PC Tuning
	Installing USB Drivers
	Installing PCLink Tuning Software
	Communicating With Your ECU

	Pre-Start Configuration
	Firmware Version
	Base Configuration
	MAP Sensor Calibration
	TPS Calibration
	IAT Sensor Selection
	Input and Output Setup
	Trigger Calibration

	First Time Startup
	Pinouts
	WRXLink (04) and WRXLink (07)

	CAN Information
	WRXLink (04) and WRXLink (07)

	Known Issues
	WRXLink (04) and WRXLink (07)



